
For the best experience, open this PDF portfolio in
Acrobat 9 or Adobe Reader 9, or later.

Get Adobe Reader Now!

http://www.adobe.com/go/reader




 Project 1 guide 


© 2008 Adobe Systems Incorporated Introduction to digital video 1 


Introduction to digital video 


Have you seen some of the amateur video productions lately? Not the ones at film festivals. We’re talking about the 
ones produced by the kid next door. Anyone can do it! 


Today, the tools for producing excellent short films are affordable and easy to use. Those tools can empower 
students of almost any age to produce personal masterpieces—complete with the look and sound of Hollywood 
productions. It's also a snap to share the finished product on DVD, the web, and virtually anywhere else. 


YES! Shooting and editing video is fun and easy. With today’s technology, you can make your movie dreams a 
reality. 


Can I really make a movie 


• Bring the excitement and energy of film festivals to classroom projects. 


• Create a short movie with video footage of the next family gatherings that everyone will enjoy.  


• Take a Saturday and turn that storyline or soap opera drama you have been thinking about into a movie for 
others to see.  


• For your next school project, make a movie that will impress everyone and show how much you know.  


• Turn the one-hour raw footage of a birthday party or baseball game into a snappy three-minute movie that 
you and your friends will be happy to watch over and over again.  


  
Going digital with video 


Getting started with digital video 


Shooting and editing video like a professional is now possible for anyone with an up-to-date computer, an 
inexpensive digital video camera, and editing software like Adobe Premiere Elements. With today’s digital video 
tools, you too can say, “Standby camera, standby talent, roll tape, ACTION!” 


Making a movie can be done with a slide show of digital pictures or video footage captured on a digital video 
camera. Either way, you can add music, sound effects, voice-overs, titles, and special video effects to make your 
movie something that will entertain your friends and make you want to watch it over and over again.  


Creating videos using today’s technology is fun and easy. With an inexpensive digital video camera, computer, and 
software like Adobe® Premiere® Elements, you can create anything from a five minute movie about your vacation 
to a feature-length film. All you have to do is get the right tools together and try it! 


Beware! Once you start making your own movies, you will never watch another movie the same way again. You will 
begin to notice things like camera angles, use of music, and special effects. Every moviemaker becomes a critic. 


Let’s get started putting the pieces together and begin capturing your memories on video and editing them into 
something you are proud to pull out or send around. This is not your boring slide shows of old. This is a 
moviemaking revolution. So grab a digital video camera and get started! 


The making of a movie 


Preproduction 


There are many different types of movies, and each one is made differently. However, they all go through the same 
process. 


Preproduction is everything from thinking about a movie all the way to writing a script (if one is used). You first 
come up with an idea of what you want. It could be simply to record a family vacation, or it could be to create a 
school project on the Civil War. Either way, some forethought should go into every production. At the very least, 
you should jot down what things you want to have in the production. 
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Take, for example, a family vacation. It is a good idea to think about the things you will do on that vacation and 
make sure that you have a little footage of each important event. Planning ahead helps you not forget some critical 
piece of the movie. For this type of preplanning, a shot list comes in handy. Here you simply list the shots you want 
to have and check them off as you get them. You can always add footage to the list, but thinking about the core 
elements of your film ahead of time is always helpful.  


For more formal productions involving many people, you may want to prepare a script. A script will put all the 
members of a production on the same page, so to speak. The two column script is most useful for video productions 
because it tells the actors what to say, the camera operators what and how they should shoot, and the editors how 
they should put it together. In the column on the left are all the visual directions, like fade-in from black and extreme 
close-up (XCU). In the column to the right are the directions for what the talent should say. If you are a teacher 
asking your students to produce a video, having your students turn in a script before they begin production is a very 
good idea. 


The ultimate in preplanning is the use of storyboards. Here you draw every shot and also list camera movements, 
talent directions, and lines. Nothing is left to chance with storyboards. If you are an elementary teacher and want 
your students to produce a movie, the use of storyboards can be very effective at getting younger students to the 
point where they are ready to shoot footage and put a movie together. 


If you are a teacher who wants to have students produce a video for a project, a student video project proposal form 
is an excellent way to get students to do a certain amount of preplanning and let you know what they are thinking. 
Have your students fill in this form to help them organize what can be a complicated process. 


Production 


Several pointers will help you better capture the action on tape: 


Capturing action for a film is an art form. Camera operators have a lot to think about while they are taping. A camera 
operator must be concerned with what is in the picture and what is not, whether there is enough light, and whether 
the camera is picking up the sound of the action or not. Anyone who has picked up a video camera at a family 
gathering knows that it is work. Filming changes your perspective from someone who is involved in the gathering to 
someone who is observing it. A little preplanning can help you determine what is important and what is not. That 
way, you can pick up the camera only when you need to rather than tape the entire event, worried that you might 
miss something important. For more formal productions that involve a script, this is where the production moves 
from abstraction to reality. 


First, determine what you want to tape. Decide what is most important and make sure it is most prominent on the 
screen. If what you are highlighting is the happiness of a particular person, move the camera close to that individual 
so that you can see the expression on his or her face. If what you want to show is a large family gathering on a lake, 
back up so that you can see all the members of the family and the lake. In filmmaking terminology, this is called the 
field of view. Take a look at the different shots below and notice that the Extreme Long Shot highlights the 
surroundings of an individual while the Extreme Close-up highlights the expression on a face. During a production, it 
is a good idea to mix up the shots so that you get a sense of surroundings and emotions. 


Second, follow the three S’s rule of Straight, Steady, and Smooth. For best results, you should use a tripod whenever 
possible. A leveled tripod will keep your video camera straight and steady. When you pan the camera left or right or 
tilt it up or down, you want the movement to be smooth as well. Try to avoid the zoom as much as possible. If you do 
have to zoom, try to also make it smooth and slow. Over-zooming is a frequent mistake of all amateurs. 


Third, make sure that you have the right amount of light. Video cameras struggle to figure out how much light they 
should let in. If you position a person in front of a window with lots of light in the background, the camera will think 
that it must not let in too much light and will darken everything else, leaving your person as a darkened figure against 
a bright background. 


Likewise, a person in direct sunlight will have deep shadows under their eyes as the camera struggles to deal with the 
other bright spots in the shot (Deep shadows pic). It is usually a better idea to shoot video in the shade, to even the 
light and eliminate deep shadows. 
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Fourth, make sure the camera can hear what it is supposed to record. Remember that the closer the camera is to what 
you want to be able to hear, the better. The camera is going to record the sounds of whatever is closest to it better 
than those sounds that are far away. Most cameras also have the ability to attach an external microphone to assist in 
picking up the right sounds. 


While these four things are listed in order, they all have equal importance in video. Nothing is more frustrating than 
watching a video in which you cannot hear what you are supposed to, or see what is going on, while being made sea 
sick by a handheld camera that is zooming in and out. These four skills separate the professional from the amateur. If 
you pay attention to them, you too can shoot like a pro. 


Postproduction 


Postproduction is where you will bring your masterpiece to life. Today’s computers, running editing software like 
Adobe Premiere Elements, let you download, screen your raw footage, trim the clips for the best parts, sequence 
them on a timeline, and add titles, music, sound effects, and special effects. With Adobe Premiere Elements, you are 
working with roughly the same technology professionals use to create documentaries, sitcoms, news broadcasts, and 
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feature films. With some extra effort, your videos can have the same professional look as those you see on TV and at 
the movies.


Initially, you will have to download the footage from the camera to your computer. Be forewarned that it transfers 
from the camera to the computer in real time, so if you shoot an hour of video, it will take an hour to download that 
footage to the camera. Video also consumes huge quantities of hard drive space (about one gigabyte for every five 
minutes of video), so the more hard drive space your computer has the better. During the process of downloading, 
you should watch the footage so that you can see what you have and begin to put the movie together in your mind.  


  


After the footage is on the computer, use the assembly cut, rough cut, and final cut stages to work with the footage. 
In each stage, you work with the entire production with increasing precision. You can spend way too much time in 
the editing phase trying to achieve perfection. Keep in mind what Steven Spielberg said: “Movies are never finished; 
they’re just abandoned.” 


Distribution 


Burn it to a DVD 
With Adobe Premiere Elements and a computer with a DVD burner, you can make your own DVDs, which can be 
played on almost all modern DVD players. Blank DVDs are about $1 each, making it possible for you to share your 
video masterpieces with anyone who has a DVD player. Some older DVD players, however, may have problems 
viewing a burned DVD.  


You have finished your masterpiece! You are ready to share it with others. In the digital world, there are many 
options for getting your movie out there. 


Send it in an e-mail 
E-mailing your movie is a fast and inexpensive way to distribute your movie, but you will have to compress your 
movie to make the movie file smaller before you send it. Your editing software, like Adobe Premiere Elements, will 
reduce the size of the movie file for you, but, in doing so, it also reduces the quality of the picture and shows the 
movie in a smaller window. 
Post it on a web page 
With Adobe Contribute CS4, you can also post your compressed movie file to a web page. If your intended audience 
has high-speed Internet access, the quality of the picture on a web page can be better than that in an e-mail because 
you will not have to compress it as much. 


Put it back on the digital video camera 
Another option you have is to put the movie back in the digital video camera. Saving it back to your camera is a 
good way to back up your movie, using a MiniDV tape. Also, when it goes back to tape, there is no compression so 
there is no loss in quality. 


To play it back from a MiniDV tape, you can then use your digital video camera like a VCR and plug the camera 
into your TV. The difficulty here is having to plug your video camera to the TV each time you want to watch a tape. 
Unfortunately, there are not as many inexpensive MiniDV tape decks as there are VCR and DVD players; otherwise, 
saving your movie back to the MiniDV tape would make a lot more sense. 


Copy it to VHS tape 
You can move your film to VHS if you copy the movie back to your camera first. Then, using the same cable you 
would use to plug the digital video camera into your TV, you plug it instead into a VCR and press play on the 
camera and record on the VCR. Your movie will be recorded to a VHS tape, which can be seen on any VCR. 
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Video shooting tips 
With a camcorder of choice in hand, it’s time to venture off and shoot videos. This guide presents a collection of tips 
and some specialized advice from a TV news chief photographer. 


Get a closing shot 
Your closing images stick in people’s minds. Be constantly on the lookout for that one shot or sequence that  wraps 
up your story effectively. It could be as simple as someone closing a door, capping a pen, petting a dog, turning out 
the lights, or releasing a butterfly from cupped hands. 


Get an establishing shot 
An establishing shot sets the scene in one image (Figure 1). Although super-wide shots work well (aerials in 
particular), consider other points of view: a race seen from the cockpit, a close-up of a scalpel with light glinting off 
its surface, paddles dipping frantically in roaring white water. Your picture should grab the viewer’s attention and 
help set up your story. 


 
Figure 1 An establishing shot (left) sets the scene and the second shot tells the story. 


Shoot plenty of video 
Videotape is cheap and expendable. Shoot more raw footage than you’ll put in your final production. Five times as 
much is not unusual. Giving yourself that latitude helps you grab shots you would have missed otherwise. 







Project 2 guide  


2 Video shooting tips © 2008 Adobe Systems Incorporated 


Adhere to the rule of thirds 
It’s called the rule of thirds, but it’s more like the rule of four intersecting lines (Figure 2). When composing your 
shot, think of your viewfinder as crisscrossed by two horizontal and two vertical lines. The center of interest should 
fall along those lines or near one of the four intersections, not in the center of the image. 


Another way to follow the rule of thirds is to look around the viewfinder as you shoot instead of staring at its center. 
Check the edges to see whether you’re filling the frame with interesting images. Avoid large areas of blank space. 


 
Figure 2 The rule of thirds 


Keep your shots steady 
You want to give viewers the sense that they’re looking through a window or, better yet, right there on location. A 
shaky camera shatters that illusion. 


When possible, use a tripod. The best ones have fluid heads so you can make smooth pans or tilts. 


If a tripod is impractical, try to find some way to stabilize the shot: lean against a wall, put your elbows on a table, or 
place the camcorder on a solid object. 


Follow action 
This might seem obvious, but keep your viewfinder on the ball (or sprinter, speeding police car, surfer, conveyor 
belt). Your viewers’ eyes will want to follow the action, so give them what they want. 


One nifty trick is to use directed movement as a pan motivator. That is, follow a leaf’s progress as it floats down a 
stream and then continue your camera motion past the leaf—panning—and widen out to show something 
unexpected: a waterfall, a huge industrial complex, some people fishing. 


Use trucking shots 
Trucking or dolly shots move with the action. For example, hold the camera at arm’s length right behind a toddler 
motoring around the house, put the camera in a grocery cart winding through the aisles, or shoot out the window of a 
speeding train. 


Find unusual angles 
Get your camcorder off your shoulder, away from eye level, for more interesting and enjoyable shots. Floor-level 
shots are great for children and pets. Shoot up from a low angle and down from a high angle. Shoot through objects 
or people while keeping the focus on your subject. 
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Lean forward or backward 
Don’t use the zoom lens as a crutch. A better way to move in close or out away from a subject is literally to lean in 
or out. For example, start by leaning way in with a tight shot of a woodcarver’s hands. Then, while still recording, 
lean way back (perhaps widening your zoom lens as well) to reveal that the carver is working in a sweatshop full of 
folks hunched over their handiwork. 


Get wide shots and tight shots 
Our eyes work like medium-angle lenses, so we tend to shoot video that way. Instead, grab wide shots and tight 
shots of your subjects (Figure 3). If practical, get close to your subject for the tight shot rather than using the zoom 
lens. Your shot will look better and the proximity will give you clearer audio. 


 
Figure 3 Wide shots and tight shots 


Shoot matched action 
Consider a shot from behind a pitcher throwing a fastball. The pitcher releases the ball and then it smacks into the 
catcher’s glove. Instead of a single shot, grab three shots: a medium shot from behind the pitcher making the pitch, a 
shot from behind the catcher of the ball in flight, and a tight shot of the catcher’s glove. Use the same concept for an 
artist: get a wide shot as the artist applies a stroke to the canvas and then move in for a close shot of the same action. 
You’ll edit them together to match the action (Figure 4). 


 
Figure 4 Matched action shots 


Get sequences 
Shooting repetitive action in sequence is another way to tell a story, build interest, or create suspense. A bowler 
wipes his hands on a rosin bag, dries them over a blower, wipes the ball with a towel, picks up the ball, fixes his 
gaze on the pins, steps forward, swings the ball back, releases it, slides to the foul line, watches the ball’s trajectory, 
and then reacts to the shot. Instead of simply capturing all this in one long shot, piece these actions together in a 
sequence of compelling edits. You can easily combine wide and tight shots, trucking moves, and matched action to 
turn repetitive material into attention-grabbing sequences. 
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Avoid fast pans and snap zooms 
These moves fall into MTV and amateur video territory. Few circumstances call for such stomach-churning 
camerawork. Minimize pans and zooms that remind viewers they’re watching TV. 


If you do zoom or pan, do it for a purpose: to reveal something, to follow someone’s gaze to the subject of interest, 
or to continue the flow of action (as in the floating leaf example). A slow zoom in, with only a minimal change to 
the focal length, can add drama to a sound bite. Again, do it sparingly. 


Note: Don’t let this no-fast-moves admonition force you to stop rolling while you zoom or pan. If you see 
something that warrants a quick close-up shot or you need to suddenly pan to grab some possibly fleeting footage, 
keep rolling. You can edit around that sudden movement later. If you stop recording to make the pan or zoom or 
adjust the focus, you might lose whatever it was you were trying so desperately to shoot. And you will miss any 
accompanying natural sound. 


Shoot cutaways 
Avoid jump cuts by shooting cutaways. A jump cut is an edit that creates a disconnect in the viewer’s mind. A 
cutaway—literally a shot that cuts away from the current shot—fixes jump cuts. 


Cutaways are common in interviews where you might want to edit together two 10-second sound bites from the 
same person, making the interviewee appear to move suddenly. To avoid that jump cut—that sudden disconcerting 
shift—make a cutaway of the interview. It could be a wide shot, a hand shot, or a reverse-angle shot of the 
interviewer over the interviewee’s shoulder. Then edit in the cutaway over the juncture of the two sound bites to 
cover the jump cut. 


The same holds true for a sports event (Figure 5). Cutting from one wide shot of players on the field to another can 
be disconcerting. If you shoot the scoreboard or some crowd reactions, you can use those cutaways to avoid jump 
cuts. 


 


 
Figure 5 A crowd reaction shot works well as a cutaway from this bloodless bullfight in Sumatra. 
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Don’t break the plane 
Breaking the plane causes another viewer disconnect. If you’re shooting in one direction, you don’t want your next 
shot to be looking back at your previous camera location (Figure 6). For instance, if you’re shooting an interview 
with the camera peering over the left shoulder of the interviewer, shoot your reverse cutaways over the interviewee’s 
right shoulder. That keeps the camera on the same side of the plane—an imaginary vertical wall running through the 
interviewer and interviewee. 


To shoot over your interviewee’s left shoulder would break that plane, meaning viewers would expect to see the 
camera that took the previous shot. 


 
Figure 6 The plane is an imaginary vertical wall running, in this case, through the interviewer and interviewee. 


In general, you want to keep all your camera positions on one side of the plane, even when shooting large-scale 
events such as football games. Although viewers won’t expect to see another camera (consciously or 
unconsciously), they might lose track of the direction of play. 


There are exceptions. When videotaping a rock group performance, for example, camera crewmembers typically 
scramble all over the stage, grabbing shots from multiple angles and even appearing on camera themselves. 


Note: If you conduct formal, sit-down interviews with more than one person for the same piece, consider shooting 
each subject from a different side of the interviewer. Shoot one subject with the camera positioned over the 
interviewer’s left shoulder. For the next interview, move the camera behind the interviewer’s right shoulder. This 
avoids a subtle jump cut that happens when you edit bites from two individuals who are facing the same direction. 
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Use lights 
Lights add brilliance, dazzle, and depth to otherwise bland, flat scenes. Consider using an onboard camcorder fill 
light and—if you have the time, money, patience, or personnel—a full lighting kit with a few colored gels. In a 
pinch, be creative about increasing available light. Open curtains, turn on all the lights, bring some desk lamps into 
the room. One caveat: Low-light situations can be dramatic, and flipping on a few desk lamps can destroy that mood 
in a moment. 


Grab good bites 
Your narrator presents the facts. The people in your story present the emotions, feelings, and opinions. Don’t rely on 
interview sound bites to tell who, what, where, when, and how. Let those bites explain the why. 


For example, your narrator should be the one to say “It was opening night and this was her first solo.” Let the singer, 
recalling this dramatic moment, say, “My throat was tight and my stomach was tied in knots.” 


Although your interviews might be lengthy, use only short sound bites in your final production. The bites should be 
punctuation marks, not paragraphs. 


Note: Make exceptions for idiosyncratic characters. Some characters you’ll videotape are so compelling, quirky, or 
humorous that your best bet is to let them do the primary narrating. Then consider scenes you can use to illustrate 
their commentary so you don’t fill your entire video with a talking head. 


Get plenty of natural sound 
Think beyond images. Sound is tremendously important. Listen for sounds you can use in your project. Even if the 
video quality is mediocre, grab that audio. Your camcorder’s onboard mic is not much more than a fallback. 
Consider using additional mics: shotgun mics to narrow the focus of your sound and avoid extraneous noise, 
lavalieres tucked out of sight for interviews, and wireless mics when your camera can’t be close enough to get just 
what you need. 


Stripe your tapes 
Adobe Premiere Pro can automate much of the video capture process. But if your digital videotape has a gap in its 
timecode, automated capture might not work. 


Gaps typically occur when you eject a partially recorded tape and then reinsert it, resetting the timecode to zero and 
leaving an unrecorded portion on the tape. With gaps, Premiere Pro can’t automatically capture clips you’ve logged. 


Stripe your tapes before shooting to resolve this issue. Place a fresh tape in your camcorder, cap your lens, press 
Record, and wait for your camcorder to record the entire tape. This lays down continuous timecode from beginning 
to end and avoids duplicate timecodes or breaks in the timecode on the tape. 


Rewind the tape and you’re ready to go. Now, as you use your camcorder, new video is recorded over the black 
video you recorded, but the timecode doesn’t change. 


Plan your shoot 
When you consider a video project, plan what you need to shoot to tell the story. How long will it be, how many 
shots will you need, who will you interview, what kind of mics and lights will you use, and how will you control the 
environment. Or will you need to respond to changing circumstances? Sporting events and concerts have a rhythm 
and flow that allow for detailed planning. A student anti-war protest can shift directions with no warning, requiring 
you to quickly change your tactics. 


In any event, no matter how you envision the finished project, be willing to make changes as the situation warrants. 
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Shot list 
Name(s):  ____________________________________________________________________________________  


Project:  ______________________________________________________________________________________  
 


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  
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How to capture video 
Before you can edit a video, you need to capture the source videotape: transfer it from a camcorder or VCR to a 
hard drive. 


Capture is a somewhat misleading term used throughout the nonlinear editing world. In the case of digital video 
(DV), all Adobe Premiere Pro CS4 does during DV capture is move the video from a DV camcorder or other 
playback device into a computer and place the video data into a wrapper, a file format Adobe Premiere Pro can read: 
AVI for Windows, MOV for Mac OS. The original DV data remain unchanged—meaning it is not compressed. 


Capturing analog video takes a few more steps: transferring, digitizing, compressing, and wrapping. The analog 
camcorder transfers the video and audio as analog waveform data via a cable to a video capture card. The card’s 
hardware digitizes the analog signal—converts it to a digital form—and then compresses it, using a codec 
(Compression/Decompression), and wraps it into a file format Adobe Premiere Pro can work with. 


Adobe Premiere Pro offers tools to take some of the manual labor out of the digital video capturing process. There 
are three basic approaches. This guide covers all of them: 


1. Manually capture an entire videotape or a tape segment. 


2. Use the Adobe Premiere Pro Scene Detect feature. Scene Detect identifies places in the original tape where 
the pause/record button on the camcorder was pressed. As Adobe Premiere Pro captures an entire tape or a 
segment, it creates separate clips starting at each pause/record instance. 


3. Log the in and out points of clips and use the batch capture feature to automatically play the DV tape, 
capture all the logged clips, name them, store them on a hard drive, and load them into the Project panel. 
This is the best way to limit the captured clips to only those keepers you want to work with in your project. 


Note: When setting up Adobe Premiere Pro for any of the three DV capture methods, you follow the same basic 
steps, so the first task covers the DV capture setup. When you finish the setup, go to any of the DV capture 
scenarios: manual, Scene Detect, or batch capture. 
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How to prepare for digital video capture 


1. Connect your DV camcorder to your computer by 
using a FireWire/iLink (IEEE 1394) cable 
(Figure 1). 


2. Turn on your camcorder and set it to the playback 
mode: VTR or VCR. Do not set it to the camera 
mode. 


 Note: When capturing video, use your camcorder’s 
AC adapter, not its battery. With a battery, 
camcorders go into sleep mode after a while, and 
the battery may run out before you finish. 


3. Start Adobe Premiere Pro and either open a saved 
project or start a new one. 


 Note: The project’s video and audio project 
settings should match the video you are about to 
capture. For example, if your project is set up for 
DV-NTSC, you can’t capture HDV video. 


4. Select File > Capture to open the Capture panel. 


5. Look above the Capture panel preview pane to 
make sure your camcorder is connected properly 
(Figure 2). 


 It should say Stopped. 


 Note: If the message says No Device Control or 
Capture Device Offline, you need to do some 
troubleshooting. The most obvious fix is to make 
sure the camcorder is turned on and the cables are 
connected. For more troubleshooting tips, refer to 
Adobe Premiere Pro Help. 


6. Click the Settings tab (in the upper-right corner of 
the Capture panel). In the Capture Locations area, 
specify where you want to store the captured video 
and audio (Figure 3). 


7. Click the Logging tab (next to the Settings tab) and 
type a name for your tape in the Clip Data area 
(Figure 4). 


 Note: Be sure not to give any two tapes the same 
name. Adobe Premiere Pro remembers clip in/out 
data based on tape names. 


 
Figure 1 FireWire/iLink connection 


 


 
Figure 2 Capture panel device status 


 


 
Figure 3 Capture panel Capture Locations area 


 


 
Figure 4 Logging tab Clip Data area 
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How to manually capture an entire videotape or a tape segment 


1. Prepare your video for capture (see “How to prepare for 
digital video capture”). 


2. Use the VCR-style device controls in the Capture panel 
to play, fast forward, rewind, step forward or backward 
a single frame, pause, and stop your tape (Figure 5). 


3. Rewind the tape to its beginning or to wherever you 
want to start recording. 


4. In the Setup area of the Logging tab, note that Audio 
And Video is the default setting (Figure 6). 


 If you want to capture only audio or only video, change 
the setting. 


5. Click the Record button in the Device Control area or 
the Tape button in the Capture area to start recording 
(Figure 7). 


 Note: The video is displayed in the Capture panel 
preview pane and on your camcorder. If the audio is 
turned up on your camcorder, you’ll hear what sounds 
like an echo coming from the computer speakers, caused 
by a slight delay during capture. Turn down either your 
camcorder or your computer speakers. 


6. When you want to stop recording, click the red Record 
button or the black Stop button. 


7. The Save Captured Clip dialog box appears. Give your 
clip a name (add descriptive information if you want) 
and click OK (Figure 8). 


 Your newly named clip appears in the Project panel. 


8. Close the Capture panel. 


 
Figure 5 Capture panel device controls 


 


 
Figure 6 Logging tab Setup area 


 


 


 


 
Figure 7 Record and Tape buttons 


 


 
Figure 8 Save Captured Clip dialog box 


 


Record and Tape buttons 
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How to use Scene Detect when capturing all or part of a DV tape 


1. Prepare your video for capture (see “How to prepare for 
digital video capture”). 


2. Use the VCR-style device controls in the Capture panel 
to play, fast forward, rewind, step forward or backward 
a single frame, pause, and stop your tape (Figure 9). 


3. Rewind the tape to its beginning or to wherever you 
want to start recording. 


4. In the Setup area of the Logging tab, note that Audio 
And Video is the default setting (Figure 10). 


 If you want to capture only audio or only video, change 
the setting. 


5. Select Scene Detect (Figure 11) in the Device Control 
area or the Capture area of the Logging tab. 


6. Name your clip in the Clip Data area of the Logging tab 
(Figure 12). 


 Note: After Adobe Premiere Pro captures clips in the 
Scene Detect mode, it places them in the Project panel 
and names and numbers them, using the clip name, as in 
Clip 01, Clip 02, and so on. 


7. If you want to capture frames that extend beyond the in 
and out points of each clip (head or tail frames), enter 
the number of frames in the Handles field in the Capture 
area of the Logging tab. 


8. Click the Record button in the Device Control area or 
the Tape button in the Capture area to start recording 
(Figure 11). 


 Note: The video is displayed in the Capture panel 
preview pane and on your camcorder. If the audio is 
turned up on your camcorder, you’ll hear what sounds 
like an echo coming from the computer speakers, caused 
by a slight delay during capture. Turn down either your 
camcorder or your computer speakers. 


9. When you want to stop recording, click the red Record 
button or the black Stop button. 


10. A set of sequentially numbered clips appears in the 
Project panel (Figure 13). 


11. Close the Capture panel. 


 
Figure 9 Capture panel device controls 


 


 
Figure 10 Logging tab Setup area 


 


 


 
Figure 11 Record, Tape, and Scene Detect buttons 


 


 
Figure 12 Logging tab Clip Data area 


 


 
Figure 13 Clips captured by using Scene Detect 


Record and Tape buttons Scene Detect buttons 
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How to use the batch capture feature 


When you perform a batch capture, you log the in and out points of a number of clips and then have Adobe Premiere 
Pro automatically transfer them to your PC. The setup for batch capture is the same as that in the previous two tasks. 


1. Prepare your video for capture (see “How to prepare for 
digital video capture”). 


2. In the Capture panel Setup area, click the Logging tab. 


3. Insert a tape into your device. 


 Adobe Premiere Pro prompts you to name the tape. 


4. Use the VCR-style controls in the Capture area to move 
to the first frame in your first shot. 


5. In the Logging tab Timecode area, click the Set In 
button (Figure 14). Then move to the last frame in the 
shot and click the Set Out button. 


6. If you want to add head or tail frames, in the Logging 
tab Capture area, change the Handles value from the 
default zero to a number that suits you (Figure 15). For 
example, try 30 frames per second). 


7. Click the Log Clip button in the Timecode area of the 
Logging tab to log the clip you identified. 


 The Log Clip dialog box appears (Figure 16). 


8. Name the clip in the Log Clip dialog box and click OK. 


 The clip’s name appears in the Project panel, with its 
in/out times and tape name info and with “Offline: User 
Requested” in its status column (Figure 17). 


 Note: To see the clip Status column in the Project panel, 
you  need to widen the panel and scroll horizontally to 
the right. If you do this, be sure to return the Workspace 
to its default view. 


9. Repeat steps 4 through 8 to log each shot you want to 
batch capture. 


 Note: You can also log clips on the fly. As you play, 
fast forward, or rewind a tape, you can click Set In or 
Set Out at any time. When you click Log Clip, the 
camcorder stops. After you type in a clip name and click 
OK, the tape returns to the play, fast forward, or rewind 
mode. 


9. When you finish logging your clips, close the Capture 
panel. 


10. In the Project panel, select all the clips you want to 
capture. 


 
Figure 14 Set In and Set Out buttons 


 


 
Figure 15 Logging tab Capture area 


 


 
Figure 16 Log Clip dialog box 


 


 
Figure 17 Project panel batch capture clip info 
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11. Select File > Batch Capture. 


 The Batch Capture dialog box appears (Figure 18). 


12. In the Batch Capture dialog box, do either of the 
following and then click OK: 


• Choose Capture With Handles and enter the number 
of frames for the handles if you want to capture 
frames beyond the in and out points identified for 
each clip in the batch. 


• Choose Override Capture Settings if you want to 
replace the capture settings of individual clips in the 
batch with the project’s default settings. 


 The Capture panel appears, as does a little dialog box 
telling you to insert the proper tape. 


13. Make sure you’ve inserted the proper tape and click OK. 


 Adobe Premiere Pro takes control of your camcorder, 
cues up the tape to the first clip, and transfers that clip 
and all other clips to your hard drive. 


 When this finishes, take a look at your Project panel to 
see the results. The clip status now says Online and the 
clip icon changes (Figure 19). If there is an error 
capturing, a batch capture log text file is added to the 
Project panel. You can double-click that link to open the 
file and troubleshoot the error. 


 
Figure 18 Batch Capture dialog box 


 


 
Figure 19 Clip info in Project panel after batch 
capture 


 


How to capture analog video 
If you need to capture analog video—consumer-level VHS, SVHS, Hi-8, or professional-grade video such as Beta-
SP—you need a video capture card with analog inputs. Most such cards have consumer-quality composite 
connectors as well as S-video and sometimes top-of-the-line component plugs. 


You need to check your card’s documentation for setup and compatibility issues. Some capture cards have specific 
presets for Adobe Premiere Pro that are available when you start a new project. Unless your camcorder has device 
control (an expensive option), you have only one capture choice: to do it manually. 


 


1. In Adobe Premiere Pro, select File > Capture. 


2. Set the camcorder to VCR and use its controls to move 
the videotape to a point several seconds before the frame 
you want to begin capturing. 


3. Press the Play button on the camcorder, and then click 
the red Record button in the Capture panel. 


4. When your clip has been captured, click the Stop button 
in the Capture panel and stop the camcorder. Your clip 
shows up in the Project panel. 
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How to apply and adjust video transitions 
Applying transitions between clips—such as dissolves, page wipes, spinning screens—can be an effective way to 
grab viewers’ attention or ease them from one scene to the next. 


Adobe Premiere Pro CS4 provides more than 75 video transitions that are easy to use and customize. The 
customization involves their placement relative to the cut line between clips, their duration, and such settings as 
colored borders, motion parameter values, and start and end locations. 


Most transition customizing takes place in the Effect Controls panel. In addition to the various options unique to 
each transition, the Effect Controls panel has a time ruler feature that makes it easy to move transitions relative to 
the cut line, move the cut line and transition together, and change the transition in and out points. 


You will need two video clips for the following tasks. 


How to apply and replace video transitions 


1. Start Adobe Premiere Pro, start a new project, and 
import two video clips. 


2. Drag the two video clips from the Project panel to the 
Video 1 track in the Timeline panel. 


3. In the Tools panel, select the Ripple Edit tool. 


4. Drag the end (out point) of the first clip to the left to 
shorten it by about 2 seconds, and drag the beginning (in 
point) of the second clip to the right about 2 seconds 
(Figure 1). 


 This gives the clips some tail and head frames so you 
can create a smooth transition. 


5. Use the Zoom Slider in the lower-left corner of the 
Timeline panel to adjust the relative size of the clips 
until they fill the width of the Timeline panel. 


6. In the Tools panel, click the Selection tool. 


7. Open the Effects panel and open the Video Transitions > 
Dissolve bin (Figure 2). 


 Note: The Effects panel contains audio and video effects 
and transitions. There is also an Effect Controls panel, 
where you can adjust effect value parameters and 
transition settings such as duration, the start and end of 
an effect or transition, and the audio volume level. 


 Note: Cross Dissolve has a red box around it indicating 
it is the default transition (Figure 2). To apply the 
default transition, move the CTI to (or near) the cut line 
between the two clips, and press Ctrl+D (Windows) or 
Command+D (Mac OS). 


 
Figure 1 Ripple Edit tool 
 


 
Figure 2 Effects panel 


 


 


Default 
transition 
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8. Drag Cross Dissolve to the cut line between the two 
clips on the sequence (Figure 3). 


 Note: If you drag the transition left or right over the cut 
line, the rectangle on top of the clips changes to show 
the placement of the transition (Figure 4): 


• Ending at the cut line (at the out point of the first 
clip) 


• Centered on the cut line 


• Starting at the cut line (at the in point of the second 
clip) 


 Transitions placed at the beginning or end of a clip are 
called single-sided. All others are double-sided. 


9. In the Timeline panel, drag the current-time indicator 
(CTI) ahead of (to the left of) the transition and click the 
Play button in the Program Monitor. 


 The transition is rendered automatically and then plays. 
The transition has a 1-second (30 frames) duration by 
default. You can change the default length in the 
General Preferences dialog box: Select Edit > 
Preferences > General (Windows) or Premiere Pro > 
Preferences > General (Mac OS). 


 Note: You can replace one transition with another by 
simply dragging a new transition to the existing 
transition in the sequence. 


10. To change the default transition, select a new transition 
in the Effects panel and select Set Selected As Default 
Transition in the Effects panel menu (Figure 5). 


 
Figure 3 Transition at a cut line 


 


 
 


Figure 4 Three transition locations and icons 


 


 
Figure 5 Effects panel menu 
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Overview of video transition settings 
After you place a transition at a cut line between two clips, you will usually want to change the transition settings. 
You make those changes in the Effect Controls panel. Each transition has its own set of options, although many 
transitions have settings in common with other transitions. To see all the transition options and the transition time 
ruler, you will probably need to drag the edges of the Effect Controls panel to expand its height and width. Here’s an 
overview of what’s available: 


• Edge selectors: Change the orientation or direction of the transition. Some transitions can move from all eight 
primary cardinal compass points (N, NE, E, SE, and so on). 


• Duration: Set the length of the transition. 


• Alignment: Place the transition starting at the cut, ending at the cut, centered at the cut, or in a custom location. 
Custom Start appears as an option in the Alignment field only if you drag the transition to a custom location 
over the cut. 


• Start And End Sliders: Start a transition with part of the transition already completed or end it before its logical 
completion. For example, the Clock wipe can start with half the face showing the next clip or end with half the 
face showing the first clip. 


• Show Actual Sources: Display the starting and ending video frames of the transition. This can help you decide 
the transition duration or the placement of certain elements. For example, the Iris Box transition has the second 
clip appear in a tiny box within the first clip. You use the starting frame to help set where that box should 
appear in the clip. 


• Border Width: Adjust the width of the optional border on the transition. The default border is None. Some 
transitions do not have borders. 


• Border Color: Specify the color of the transition’s border. You can select a color from the color swatch or use 
the eyedropper to select the color from a video clip. 


• Reverse: Play the transition backward. For example, the Curtain transition closes and the Clock Wipe transition 
plays counterclockwise. 


• Anti-aliasing Quality: Aliasing is the jagged, stair-step edge common along sharply defined lines on computer 
monitors and TV sets. This is most noticeable when the transition is not a horizontal or vertical move. To get rid 
of aliasing (to soften that edge), you select Anti-Aliasing. This option is available for transitions that have 
borders. 


• Custom: Only a handful of transitions have custom settings. Here are some examples: Zoom Boxes—number of 
boxes, Band Wipe—number of bands, and Card Flip—Rows, Columns, Flip Order, and Axis. 


• Positioning Circles: Locate the starting and ending points of a transition within a clip’s frame. For example, Iris 
Star has the second clip appear in the first clip as a tiny star that grows to a full-screen clip. You use the starting 
positioning circle to place where in the first clip that tiny star appears. Most transitions don’t have positioning 
circles. 
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How to adjust reverse and positional circle settings 
Changing most of the transition settings is straightforward. However, reverse and positional circles need some 
explanation. Here is an overview of those settings. 


 


1. Continue working with the clips you added earlier in 
this guide, or start a new sequence, add two clips to it, 
and trim their respective out and in points. 


2. In the Effects panel, open the Video Transitions and Iris 
bins, and then drag Iris Round effect to the end of the 
last clip. 


 Note: The only placement option when applying a 
transition to the end of the last clip in a sequence is to 
have the transition end at the out point. This is a single-
sided transition (Figure 6). 


3. Click the Iris Round transition rectangle at the end of the 
clip to select it and to display its parameters in the Effect 
Controls panel. 


4. Play the transition and note that the iris opens outward, 
giving the appearance of a growing black circle. 


 That is the default action for the Iris Round transition. 
Instead the iris should appear to close down on the 
video, creating the effect of closure. 


5. In the Effect Controls panel, select the Reverse option 
and view the transition in the Program Monitor 
(Figure 7). 


 Note: Reverse changes the action of a transition.  


6. Drag the Iris Box transition from the Effects panel to the 
cut line between the two clips in the sequence. 


7. Click the Iris Box transition rectangle at the cut line 
between the two clips to display its parameters in the 
Effect Controls panel. 


 Iris Box has an option you have not seen up to this 
point: a positioning circle in the Start clip preview pane 
(Figure 8). 


8. Move the positioning circle in the Start screen to change 
the location where the zoom boxes will start and finish 
(Figure 8). 


 Note: Because there is only one positioning circle for 
Iris Box (some transitions have both start and end 
positioning circles), the transition starts and ends in the 
same relative position within the frames of the two clips. 


9. Play the transition. 


 
Figure 6 Iris Round transition placed at end of 
clip 


 


 
Figure 7 Iris Round transition 


 


 


 
Figure 8 Transition Clip preview panes 
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How to adjust transitions in the Effect Controls time rule 


You can make several types of adjustments to transitions in the Effect Controls time ruler: 


• Adjust transition alignment: You can drag the 
transition to reposition it over the cut. 


• Move the cut line and transition together: This is 
the same as performing a rolling edit in the 
Timeline panel. As you move the cut, the transition 
moves with it. Move the cut line and transition 
together by positioning the cursor on the thin 
vertical cut line (the pointer changes from the Slide 
Transition tool to the Rolling Edit tool) and 
dragging left or right (Figure 9). 


• Change the transition in and out points: Use the 
time ruler to drag either end of the transition and 
precisely position it relative to the clips. Change the 
in or out points of the transition by positioning the 
pointer over the transition until the Trim-in or Trim-
out tool appears and then drag left or right 
(Figure 10). 


 
Figure 9 Rolling Edit tool 


 


 
Figure 10 Trim-out tool 
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How to use Source Monitor editing tools 
Trimming clips before placing them on the Timeline is helpful. You trim a clip by putting it in the Source Monitor, 
trimming it there, and then adding it to a sequence in the Timeline. When you use the Source Monitor to add a clip 
to a sequence, you can use an Insert edit or an Overlay edit. You can choose to add both video and audio, audio 
only, or video only. 


How to trim clips in the Source Monitor 


1. Start Adobe Premiere Pro and open an existing project 
that has at least four video clips with audio. 


2. Double-click a video clip in the Project panel. 


 The selected clip appears in the Source Monitor 
(Figure 1). 


 Note: You also can drag the clip from the Project panel 
to the Source Monitor. 


3. Drag the Source Monitor current-time indicator (CTI) to 
where you want to put the in point in the clip. 


4. Click the Set In Point button from the Source Monitor 
trimming tools (Figure 2). 


 A left-bracket appears in the time ruler, with a light-blue 
shading to the right (Figure 1). 


5. Play the clip, look for a logical out point, and drag the 
Source Monitor CTI there. 


 Note: Rather than drag the CTI to a location in the clip, 
you can type in a timecode and go there directly. Click 
the gold timecode (on the left side of the Source 
Monitor), type a time (hours, minutes, seconds, frame), 
and press Enter (Windows) or Return (Mac OS). 


6. Click the Set Out Point button from the Source Monitor 
trimming tools (Figure 2). 


 A right-bracket appears and the light blue shading falls 
between the in point and out point (Figure 1). 


7. Click the Go To In Point button and then the Go To Out 
Point button to navigate back and forth between the in 
point and out point. 


8. Play the entire segment by clicking the Play In To Out 
button. 


 
 


 


Figure 1 Source Monitor 


 


 


 


 
Figure 2 Source Monitor trimming tools 
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How to use the Source Monitor to add clips to a sequence 


1. Continue where you left off in the previous task. 


2. In the Timeline panel, move the CTI to the beginning of 
the sequence. 


3. Check to see that the Video 1 and Audio 1 track headers 
are targeted (highlighted) (Figure 3). 


 To target a video or audio track, click its header. 


4. In the Source Monitor, click the Insert button (Figure 4) 
to place this clip at the CTI line in the sequence. 


5. In the Project panel, double-click a second video clip to 
put that clip in the Source monitor. 


6. Click the triangle to the right of the current clip’s name 
on the Source tab at the top of the Source Monitor 
(Figure 5). 


 The Source menu appears. 


 All clips added to the Source Monitor appear in this 
menu. You change the clip displayed in the Source 
Monitor by selecting it here. You can remove all clips 
from the Source Monitor menu by selecting Close All, 
or remove them one at a time by selecting a single clip 
and selecting Close. 


7. In the Source Monitor, set in and out points for the 
newly added clip. 


8. Check that the Timeline panel CTI is at the end of the 
first clip (it goes there automatically after an Insert or 
Overlay edit). 


9. In the Source Monitor, click the Insert button. 


 The newly added clip (the second clip) appears in the 
sequence to the right of the first clip (Figure 6). 


10. Add a third video clip to the Source Monitor and set in 
and out points for that video clip. 


11. In the Timeline panel, place the Timeline CTI between 
the first and second clips. 


  


 
Figure 3 Timeline panel with targeted tracks 
 


 
Figure 4 Source Monitor editing tools 
 


 
Figure 5 Source menu  
 


 
Figure 6 Insert edit 
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12. In the Source Monitor, click the Insert button to do a 
standard Insert edit. 


 The new clip is placed at the CTI and the clip that was 
previously to the right of the cut line is shoved farther to 
the right in the sequence to make room for the new clip 
(Figure 7). 


13. Add a fourth clip to the Source Monitor, and set in and 
out points for that video clip. 


 In the next step, you will insert the video only (no 
sound) to the Timeline. You will do this by dragging the 
video from the Source Monitor. 


14. Drag the Drag Video Only icon from the Source 
Monitor (Figure 8) to the cut line between the second 
and third clips (Figure 9). (You may need to make the 
Source Monitor wider to see the Drag Video Only icon.) 


 The new clip covers the previously placed third clip, but 
because you selected video-only, the audio does not 
change (Figure 10). 


  


15. Play the sequence to see how the Overlay edit works. 


 Note: To overlay the audio only, use the Drag Audio 
Only icon in the Source Monitor. It looks like a speaker, 
and appears to the right of the Drag Video Only icon. 


 
Figure 7 Insert edit 
 


 
Figure 8 Drag Video Only icon 
 


 
Figure 9 Drag the video only to the cut line 
 


 
Figure 10 Video-only Overlay edit 
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How to create standard image, movie, and audio files 
In this guide, you export sequences, clips, and video frames to several standard computer-file formats. Later you will 
work with the Adobe Media Encoder to create files for distribution on DVDs or the web or on iPods, cell phones, 
and other mobile devices. 


You can export a single video frame as an image by selecting one of several file types. Or you can export a video 
clip, a portion of a clip, an entire sequence, or a segment from a sequence as an audio/video file, audio-only file, or 
video-only file. 


When you export a clip or sequence as a standard computer video or audio file, it is typically rendered without 
compression at the full resolution of the project. You will be able to edit these files later like any other video clip 
without loss of quality or performance. You might choose to export sequences or clips into uncompressed files for 
either of the following reasons: 


• To flatten the contents of a multitrack sequence into single video and audio tracks to use in another project 


• To convert a large project with many clips into a more manageable form 
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How to make single-frame image files 


1. Start Adobe Premiere Pro and open an existing project. 


2. In the Timeline panel, move the current-time indicator 
(CTI) to the video frame you want to export. 


3. Select File > Export > Media. 


 The Export Settings dialog box appears (Figure 1). The 
most recently used file format is selected. 


4. Open the Format menu and select a file type for the 
image (Figure 2).  


 Note: Three of the image file types—Windows Bitmap 
(Windows only), Targa, and TIFF—are uncompressed. 
They retain the full image quality of the selected frame. 
GIF (Windows only) is a highly compressed format 
(about 20% as large as the other three formats) and does 
not retain the full image quality. 


5. Depending on which file format you selected, you can 
select from additional file settings on the Preset menu.  


6. Click the Output Name to open the Save As dialog box.  


7. Select a location and enter a name for the file in the File 
Name box (Windows) or Save As box (Mac OS). Click 
Save. 


8. Click the Video tab in the lower-right panel of the 
Export Settings dialog box to switch to the video 
settings.  


 Note that you can change the frame size and pixel aspect 
ratio (Figure 3). 


 Note: When you export still images from NTSC DV 
clips for use in square-pixel graphics or video, you can 
prevent distortion by setting Aspect to Square Pixels 
(1.0) and changing the frame size from 720 x 480 to 640 
x 480 pixels. 


9. Make sure that Export As Sequence is not selected 
(Figure 3), and click OK. 


 The file is exported to the Adobe Media Encoder, which 
processes the file based on your selections.  


10. On your computer, navigate to the Adobe Media 
Encoder window to view the progress of the export. 
When the export is complete, close the Adobe Media 
Encoder window. 


 Note: You can create a still image directly from a clip in 
the Project panel. Simply select a clip and follow the 
steps used to create a still image from a frame in a 
sequence. The one drawback to this method: you can use 
only a clip’s first frame to make a still image. 


 
Figure 1 Export Settings dialog box 


 


 
Figure 2 Format menu 


 


 
Figure 3 Export Settings, Video tab 
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How to export a clip or a range of frames within a clip 


1. Start Adobe Premiere Pro and open an existing project 
with a clip you want to export. 


2. Do one of the following: 


• To export an entire clip, select the clip in the Project 
panel. 


• To export a range of frames in a clip, do the 
following: 


o In the Project panel, double-click the clip to 
open it in the Source Monitor (Figure 4). 


o Drag the Source Monitor CTI to where you 
want the exported clip to begin, and click the 
Set In Point button (Figure 4). 


o A left-bracket appears in the time ruler, with 
light-blue shading to the right. 


o Drag the Source Monitor CTI to where you 
want the clip to end and click the Set Out Point 
button. 


o A right-bracket appears and the light-blue 
shading falls between the in point and the 
out point. 


3. Select File > Export > Media. 


 The Export Settings dialog box appears (Figure 5). The 
most recently used file format is selected. 


4. Open the Format menu and select a file type for the 
sequence (Figure 6). The following is a partial list of 
options. 


• FLV | F4V (H.264): Creates Adobe Flash Video, the 
format for delivering audio and video over the web 
and other networks. Adobe Flash Video will play on 
any computer with a Flash-enabled browser. 


• H.264: An MPEG-4-based standard for web 
delivery and for a variety of devices, including HD 
video, 3GPP cell phones, video iPods, and 
PlayStation Portable (PSP) devices.  


• QuickTime: Creates a compressed or uncompressed 
video file. (In Windows, you must have QuickTime 
installed.) 


• Microsoft AVI (Windows only): Creates a 
compressed or uncompressed video file. 


• Microsoft DV AVI (Windows only): Creates an 
uncompressed video file. 


 


 


 
Figure 4 Source Monitor Set In Point and Set Out 
Point buttons 


 


 
Figure 5 Export Settings dialog box 


 


 
Figure 6 Format menu 
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Note: Uncompressed Microsoft AVI is used to create 
high-definition video only. Filmstrip and Animated GIF 
(both Windows only) create sequences of image files to 
which you can add graphics in a process called 
rotoscoping. 


5. Depending on which firmat you selected, you can select 
from additional file settings on the Preset menu.  


6. Click the Output Name to open the Save As dialog box.  


7. Select a location and enter a name for the file in the File 
Name box (Windows) or Save As box (Mac OS). Click 
Save. 


8. Make sure that Export Video and Export Audio are 
selected (Figure 7). 


9. Click the Video tab in the lower-right panel of the 
Export Settings dialog box to display the video settings 
(Figure 8). 


 Note: QuickTime and Microsoft AVI together have 
more than 20 codecs (compression/decompression 
algorithms) associated with them. Each video and audio 
compressor has attributes that work best under certain 
circumstances. For more background on compression, 
read the DV Compression Primer on the Adobe website 
at http://media.studio.adobe.com/go/DV_Compression_ 
Primer.pdf. 


10. Click the Audio tab to display the audio settings 
(Figure 9). 


 Audio codec, sample rate, sample type, channels (mono 
or stereo), and audio interleave settings are available. 
For detailed explanations of these items, see Adobe 
Premiere Pro Help. 


11. Click OK to export the selected clip or range of frames. 


 The clip is exported to the Adobe Media Encoder, which 
processes the file based on your selections.  


10. On your computer, navigate to the Adobe Media 
Encoder window to view the progress of the export. 
When the export is complete, close the Adobe Media 
Encoder window. This can take several minutes 
depending on the length of the video. 


  


 


 
Figure 7 Export Video and Export Audio selected 


 


 
Figure 8 Export Settings, Video tab 


 


 
Figure 9 Export Settings, Audio tab 
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How to export an entire sequence or a sequence segment 


1. Start Adobe Premiere Pro and open an existing project 
with a sequence you want to export. 


2. Do one of the following: 


• To export a sequence, select the sequence in the 
Timeline panel or click on its icon in the Project 
panel. 


• To specify a range of frames in a sequence to 
export, do the following: 


o Select the sequence in the Timeline panel. 


o In the Timeline panel, set the work area by 
dragging the work area bar handles to the in 
and out points of the segment you want to 
export (Figure 10). 


3. Select File > Export > Media. 


 The Export Settings dialog box appears (Figure 11). 


4. Open the Format menu and select a file type for the 
sequence (Figure 12).  


• QuickTime: Creates a compressed or uncompressed 
video file. (In Windows, you must have QuickTime 
installed.) 


• Microsoft AVI (Windows only): Creates a 
compressed or uncompressed video file. 


• Microsoft DV AVI (Windows only): Creates an 
uncompressed video file. 


Note: Uncompressed Microsoft AVI is used to create 
high-definition video only. Filmstrip and Animated GIF 
(both Windows only) create sequences of image files to 
which you can add graphics in a process called 
rotoscoping. 


5. Depending on which file format you selected, you can 
select from additional file settings on the Preset menu.  


 


 
Figure 10 Timeline panel work area bar handles 


 


 
Figure 11 Export Settings dialog box 


 


 
Figure 12 Format menu 
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6. Click the Output Name to open the Save As dialog box.  


7. Select a location and enter a name for the file in the File 
Name box (Windows) or Save As box (Mac OS). Click 
Save. 


8. Make sure that Export Video and Export Audio are 
selected (Figure 13). 


9. Click the Video tab in the lower-right panel of the 
Export Settings dialog box to display the video settings 
(Figure 14). 


 Note: QuickTime and Microsoft AVI together have 
more than 20 codecs (compression/decompression 
algorithms) associated with them. Each video and audio 
compressor has attributes that work best under certain 
circumstances. For more background on compression, 
read the DV Compression Primer on the Adobe website 
at http://media.studio.adobe.com/go/DV_Compression_ 
Primer.pdf. 


10. Click the Audio tab to display the audio settings 
(Figure 15). 


 Audio codec, sample rate, sample type, channels (mono 
or stereo), and audio interleave settings are available. 
For detailed explanations of these items, see Adobe 
Premiere Pro Help. 


11. Click OK to export the selected sequence or sequence 
segment. 


 The selection is exported to the Adobe Media Encoder 
which processes the file based on your selections.  


12. On your computer, navigate to the Adobe Media 
Encoder window to view the progress of the export. 
When the export is complete, close the Adobe Media 
Encoder window. This can take several minutes 
depending on the length of the video. 


 


 
Figure 13 Export Video and Export Audio 
selected 


 


 
Figure 14 Export Settings, Video tab 


 


 
Figure 15 Export Settings, Audio tab 


 



http://media.studio.adobe.com/go/DV_Compression_%0BPrimer.pdf�

http://media.studio.adobe.com/go/DV_Compression_%0BPrimer.pdf�





Adobe Premiere Pro CS4 Project 2 guide 


© 2008 Adobe Systems Incorporated How to create standard image, movie, and audio files 7 


How to export audio only 


1. Start Adobe Premiere Pro and open an existing project 
with a sequence or clip you want to export as an audio 
file. 


2. Select the sequence or a clip. 


3. Select File > Export > Media. 


 The Export Settings dialog box appears (Figure 16). 


4. Open the Format menu and select a file type for the 
audio file (Figure 17).  


5. Depending on which file format you selected, you can 
select from additional file settings on the Preset menu. 


6. Click the Output Name to open the Save As dialog box.  


7. Select a location and enter a name for the file in the File 
Name box. Click Save. 


  The Audio tab (at the bottom of the dialog box) should 
be selected automatically (Figure 18). You can select an 
audio codec, sample rate, sample type, channels (mono 
or stereo), and audio interleave. For detailed 
explanations of these items, see Adobe Premiere Pro 
Help. 


8. Click OK to export the selected sequence or clip. 


 The selected file is exported to the Adobe Media 
Encoder which processes the file based on your 
selections. When exporting audio file formats, Adobe 
Media Encoder will extract the audio from the clip or 
sequence to produce the output audio file.  


9. On your computer, navigate to the Adobe Media 
Encoder window to view the progress of the export. 
When the export is complete, close the Adobe Media 
Encoder window.  


 


 
Figure 16 Export Settings dialog box 


 


 
Figure 17 Format menu 


 


 
Figure 18 Export Settings, Audio tab 
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Peer review 
Name: _______________________________________________________ Date: ________________________  


Project: ______________________________________________________ 


Overview 
Revision is an important part of the design process. In addition to conducting review and redesign cycles personally 
and with your client, using peer review can also be beneficial to your project. Peer review occurs in many 
professional environments, and it is an essential skill to starting learning. 


When giving peer review, be sure to make both positive and negative points. Give critiques as suggestions, not 
commands. When receiving peer review, do not feel disenchanted or think you did a bad job based on one review. 
Every review is different and what one person may not approve, the next person may find exemplary. 


Process for presenting work for peer review 
• When presenting your work for peer review, state the purpose, audience, and goals of your video and point 


out any concerns you have. 


• When someone else presents work for you to review, your first response should be to reiterate their 
purpose, audience, and goals.  


• When the producer’s purpose, audience, and goals are clear, ask questions of the producer, make 
comments, and offer suggestions. 


• To conclude, have the producer summarize the suggestions and offer a plan for revision. 


Guidelines for giving comments and suggestions 
• Before making any comments, review the entire video and make sure you understand the producer’s 


intentions. 


• Point out the strengths as well as the weaknesses of the video (shot selection, writing, transitions, effects, 
and so on). 


• Offer suggestions, not commands. For instance, do not say “You should do this….” Instead, use “I” 
statements: “I see that…” or “I’m confused about....” 


• Be respectful and considerate of your peer’s feelings. Do not say or write anything you wouldn’t want to 
hear about yourself. There is no reason to be rude. 


• Make sure your comments are clear and specific so your peer knows what you are referring to. Give 
specific examples and point to video shooting techniques, editing techniques, script writing, and so on to 
make your point. (Comments such as “This is unclear” or “This is too vague” are too general to be helpful. 
Rather, make a comment such as “I’m confused by this clip because it seems out of place.”) 


• If you are writing your comments, reread them before giving them to your peer. Make sure your comments 
make sense and are easy to follow. 


 









